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1 Introduction 
1.1 About This Manual 

This manual describes the Eaton EU5C-SWD-POWERLINK 
SmartWire-DT Gateway. Here you will find information on how to install, 
configure and operate the gateway. 

This manual is intended for automation technicians and engineers. Detailed 
knowledge of Ethernet POWERLINK is presumed. In addition, readers 
should also be familiar with the handling of the SmartWire-DT system. 

IMPORTANT! 

 To avoid personal injuries or damage of electrical devices, please read
this manual carefully before installing and using the EU5C-SWD-
POWERLINK Gateway.

 Please first read the Safety chapter on page 16 ff.

1.1.1 List of Revisions 
Revision Date Chapter Revisions 
1 2013-10-15 All Created

2 2013-12-09 9.2 Section Diagnosis/Status Response revised. 

Table 1: List of Revisions  
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1.1.2 Conventions in this Manual 
Notes, operation instructions and results of operation steps are marked as 
follows: 

Notes 

Important: <important note> 

Note:  <note> 

<note, where to find further information> 

Operation Instructions 

1. <instruction>

2. <instruction>

or 

 <instruction>

Results 

 <result>

For a description of the labeling of Safety Messages, see Labeling of 
Safety Messages section on page 20. 
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1.2 Versions of Devices, Firmware, Software Tools, Drivers 
and Device Description File 

The hardware revisions and software versions functionally belong together. 
This means that certain revisions of the hardware of the gateway need 
certain versions of firmware, software and drivers, in order to function 
properly.  
This section lists the hardware revisions and the versions of the firmware, 
the configuration software and the drivers which functionally belong 
together and to which all instructions in this manual refer. 

Device and Firmware 
This manual refers to the following hardware revision and firmware version 
of the EU5C-SWD-POWERLINK Gateway:  

Device type name Protocol Part number Hardware 
revision 

Firmware Firmware 
version 

EU5C-SWD-POWERLINK POWERLINK 
Controlled Node 

9233.921 3 E030K0U0.nxf 1.0.x.x

Table 2: Reference to Hardware and Firmware 

Software Tools 
This manual refers to the following software versions: 

Software Manufacturer Version 
Ethernet Device Configuration Tool  Eaton 1.501 

Automation Studio Bernecker + Rainer 3.0.90 

SWD-Assist Eaton 1.90 

Table 3: Reference to Software Tools 

Drivers 
This manual refers to the following driver versions: 

Driver File name Version 
Windows USB Driver usbser.sys Depending on 

Windows version 

Table 4: Reference to Drivers 
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1.3 Software Package 
You need the SWD-Assist software in order to configure the EU5C-SWD-
POWERLINK gateway.  

The software can be ordered separately from Eaton under the product 
name EU5C-SWD-SW (order number 3233.920). The package contains the 
SmartWire-DT Gateway Solutions product DVD and a Mini-USB cable. 

You can download the contents of the product DVD as ZIP file free of 
charge from our website www.eaton.com under Products > Gateways or 
under Support > Downloads. 

1.3.1 Contents of the Product DVD 
There is one product DVD, which can be used for several types of 
gateways.  

The SmartWire-DT Gateway Solutions product DVD includes:  

 Device description files

Note: A device description file for the EU5C-SWD-POWERLINK Gateway 
is not provided on the product DVD. The project-specific XDD device 
description file for the POWERLINK-Gateway has to be generated by the 
SWD-Assist software. 

 Firmware

 Eaton SWD-Assist software

 Wizard for installing the software available on the DVD and for 
downloading the latest version of the SWD-Assist software from the 
internet

 Installation program for USB driver (USB driver is needed for connecting 
the gateway to a PC in order to use the Eaton SWD-Assist software)

 Installation program for the Eaton Ethernet Device Configuration Tool

 Documentation in PDF format

 Installation program for Adobe Reader

http://www.hilscher.com/�
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The product DVD has the following directories: 

Directory Contents 
Documentation PDF manuals in German and English and installation program for Adobe Reader 

Driver Folder containing installation program (setup.exe) and .INF- and .CAT- files for 
Windows USB driver. 

EDS Electronic device description files and bitmaps, to be imported directly into 
Master/Controller configuration software.  
Note: The device description file for the EU5C-SWD-POWERLINK Gateway has to be 
generated by the SWD-Assist software. 

Firmware Loadable gateway firmware  

fscommand Files for start screen of product DVD 

Software SWD-Assist software 
Folder: Software\SWD-Assist 

Wizard for installing the software available on the DVD and for downloading the latest 
version of the SWD-Assist software from the internet 
Folder: Software\Setup 

Installation program for Ethernet Device Configuration Tool 
Folder: Software\EnDeviceCfg 

Table 5: Directory of DVD  

Note: You can use the wizard on the product DVD to download updates of 
the Eaton SWD-Assist software, or you can download SWD-Assist directly 
from the www.moeller.net website under Support > Download Center. 
Direct link:  
http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99 

You can download other content stored on the DVD from the Eaton 
website www.eaton.com under Support > Downloads. 

http://downloadcenter.moeller.net/en/software.a487d8b7-da91-486f-b3ba-a7ca2035db99�
http://www.hilscher.com/�
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1.3.2 How to Use the Product DVD 
Insert the SmartWire-DT Gateway Solutions product DVD into the DVD 
drive of your configuration PC.  
If the auto start function of your DVD drive is enabled, the start screen of 
the DVD automatically opens. You can also start the DVD by double-
clicking the SmartWire.exe file in the root directory of the DVD. 

In the menu of the start screen of the DVD, click Install Planning and 
Configuration Tools to open a wizard for installing the software programs 
stored on the DVD. The wizard also helps you to download the latest 
version of the Eaton planning software SWD-Assist from the internet. It 
automatically checks for already installed software components (which e. g. 
might have been installed for an earlier project), and lists the missing 
components accordingly. The following options might be offered: 

 USB driver: installs USB driver for Windows on your PC.

 SWD Planning Software SWD-Assist V1.90: installs version 1.90 of 
the SWD-Assist software (provided on the DVD) on your PC.

 Download Center SWD-Assist, manual update check: connects your 
browser to a web page where you can download the latest version of the 
SWD-Assist software.

 Ethernet Device Scanner/Configuration Tool: installs the Eaton 
Ethernet Device Configuration Tool on your PC.

 PROFINET GSDML File: opens a link to the device description file of 
the EU5C-SWD-PROFINET gateway.

Note: A device description file for the EU5C-SWD-POWERLINK Gateway 
is not provided on the product DVD. The device description file for the 
POWERLINK gateway has to be generated by the SWD-Assist software 
specifically for the project. 

In the menu of the start screen of the DVD, you can also open folders 
(directories) in which the documentation, the USB driver and the GSDML 
file are stored.  
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1.3.3 Notes on Installing the USB Driver 
Before you connect the EU5C-SWD-POWERLINK Gateway via USB to 
your configuration PC (in order to use the SWD-Assist software), you 
should first install the USB driver on your PC. 

To install the USB driver from the DVD, choose Install Planning and 
Configuration Tools in the DVD menu to open the installation wizard, and 
then select the USB driver option. As an alternative, you can use the 
Windows Explorer to open the Driver\USB\Windows folder on the DVD, 
and then double-click the setup.exe file. Just follow the instructions of the 
installation routine afterwards. 

Note: Under Windows XP, the installation process is not yet finished by 
the setup. The installation process has to be completed in the Found new 
Hardware Wizard, which automatically opens when you connect the 
gateway to a PC via USB cable for the first time (see below). 

Windows XP 
When you connect the gateway via USB for the first time to a PC running 
under Windows XP, the Found New Hardware Wizard opens:  

 Answer the question Can Windows connect to Windows Update…?,
with No, not this time. Then click Next button.

 If you have already carried out the setup of the USB driver (as
recommended), you can ignore the wizard’s request to insert a CD or
floppy disk. Answer the What do you want the wizard to do? question
by selecting the Install the software automatically option, then click
Next button.

 After the installation is complete, click Finish button.

Windows 7 and 8 
If you have carried out the setup of the USB driver before first connecting 
the USB cable (as recommended), then the USB connection is 
instantly operative under Windows 7 and 8. 

Uninstall USB Driver 
If you want to remove the USB driver from a PC running under 
Windows XP, choose Start menu > Control Panel > Add or Remove 
Programs, then select:  
Windows Driver Package – Eaton Ports entry. 

Click Change/Remove button to uninstall the driver. 

Under Windows 7 and 8, choose Start menu > Control Panel > Uninstall 
a program, then select: 
Windows Driver Package – Eaton Ports entry. 

Click Uninstall/Change button to uninstall the driver. 
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1.4 Documentation Overview 
Besides this user manual at hand (path on product DVD: 
Documentation\english\2. Hardware\EU5C-SWD-POWERLINK UM 
01 EN.pdf), the following documents are also relevant for the user of the 
EU5C-SWD-POWERLINK Gateway:  

Title Contents Publisher Document ID Path on product DVD 
SmartWire-DT 
Units 

Information on engineering, 
installation and 
programming of the 
individual SmartWire-DT 
slaves. 

Eaton 05/11 
MN05006001Z-EN 

Documentation\english\ 
3.SmartWire-
DT\SmartWire-DT – Units\
MN05006001Z_EN.pdf

SmartWire-DT 
The System 

Information on function, 
installation, commissioning 
and diagnostics of the 
SmartWire-DT system. 

Eaton 02/11 
MN05006002Z-EN 

Documentation\english\ 
3.SmartWire-
DT\SmartWire-DT - The
System\
MN05006002Z_EN.pdf

Ethernet Device 
Configuration 

Operating Instruction 
Manual of Eaton Ethernet 
Device Configuration Tool. 

Eaton DOC050402OIxxEN Documentation\english\ 
1.Software\Ethernet
Device Setup Utility\
Ethernet Device
Configuration OI xx
EN.pdf

SWD-Assist 
Online help 

Online help for SWD-Assist 
planning software 

Eaton - Included in SWD-Assist software

B&R Help 
Explorer – 
Automation 
Studio 

Online help for Automation 
Studio software 

Bernecker 
+ Rainer

- Included in Automation Studio 
software 

Table 6: Documentation Overview 
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1.5 Legal Notes 

1.5.1 Copyright 
© Eaton 2013   

All rights reserved. 

The images, photographs and texts in the accompanying material (user 
manual, accompanying texts, documentation, etc.) are protected by 
German and international copyright law as well as international trade and 
protection provisions. You are not authorized to duplicate these in whole or 
in part using technical or mechanical methods (printing, photocopying or 
other methods), to manipulate or transfer using electronic systems without 
prior written consent. You are not permitted to make changes to copyright 
notices, markings, trademarks or ownership declarations. The included 
diagrams do not take the patent situation into account. The company 
names and product descriptions included in this document may be 
trademarks or brands of the respective owners and may be trademarked or 
patented. Any form of further use requires the explicit consent of the 
respective rights owner. 

1.5.2 Important Notes 
The user manual, accompanying texts and the documentation were created 
for the use of the products by qualified experts, however, errors cannot be 
ruled out. For this reason, no guarantee can be made and neither juristic 
responsibility for erroneous information nor any liability can be assumed. 
Descriptions, accompanying texts and documentation included in the user 
manual do not present a guarantee nor any information about proper use 
as stipulated in the contract or a warranted feature. It cannot be ruled out 
that the user manual, the accompanying texts and the documentation do 
not correspond exactly to the described features, standards or other data of 
the delivered product. No warranty or guarantee regarding the correctness 
or accuracy of the information is assumed.  

We reserve the right to change our products and their specification as well 
as related user manuals, accompanying texts and documentation at all 
times and without advance notice, without obligation to report the change. 
Changes will be included in future manuals and do not constitute any 
obligations. There is no entitlement to revisions of delivered documents. 
The manual delivered with the product applies.  

Eaton is not liable under any circumstances for direct, indirect, incidental 
or follow-on damage or loss of earnings resulting from the use of the 
information contained in this publication. 
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1.5.3 Exclusion of Liability 
The software was produced and tested with utmost care by Eaton 
and is made available as is. No warranty can be assumed for the 
performance and flawlessness of the software for all usage conditions 
and cases and for the results produced when utilized by the user. 
Liability for any damages that may result from the use of the hardware or 
software or related documents, is limited to cases of intent or grossly 
negligent violation of significant contractual obligations. Indemnity 
claims for the violation of significant contractual obligations are limited to 
damages that are foreseeable and typical for this type of contract. 

It is strictly prohibited to use the software in the following areas: 

 for military purposes or in weapon systems;

 for the design, construction, maintenance or operation of nuclear
facilities;

 in air traffic control systems, air traffic or air traffic communication
systems;

 in life support systems;

 in systems in which failures in the software could lead to personal injury
or injuries leading to death.

We inform you that the software was not developed for use in dangerous 
environments requiring fail-proof control mechanisms. Use of the software 
in such an environment occurs at your own risk. No liability is assumed for 
damages or losses due to unauthorized use. 

1.5.4 Warranty 
Although the hardware and software was developed with utmost care and 
tested intensively, Eaton does not guarantee its suitability for any 
purpose not confirmed in writing. It cannot be guaranteed that the 
hardware and software will meet your requirements, that the use of the 
software operates without interruption and that the software is free of 
errors. No guarantee is made regarding infringements, violations of 
patents, rights of ownership or the freedom from interference by third 
parties. No additional guarantees or assurances are made regarding 
marketability, freedom of defect of title, integration or usability for 
certain purposes unless they are required in accordance with the law 
and cannot be limited. Warranty claims are limited to the right to claim 
rectification. 
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1.5.5 Export Regulations 
The delivered product (including the technical data) is subject to export or 
import laws as well as the associated regulations of different counters, in 
particular those of Germany and the USA. The software may not be 
exported to countries where this is prohibited by the United States Export 
Administration Act and its additional provisions. You are obligated to 
comply with the regulations at your personal responsibility. We wish to 
inform you that you may require permission from state authorities to export, 
re-export or import the product. 

1.5.6 Trademarks 
SmartWire-DT® is a registered trademark of Eaton Corporation. 

Windows® XP, Windows® 7 and Windows® 8 are registered trademarks of 
the Microsoft Corporation.  

Adobe-Acrobat® is a registered trademark of Adobe Systems Incorporated. 

Ethernet POWERLINK and B & R Automation Studio are trademarks of 
B&R, Bernecker + Rainer Industrie-Elektronik Ges.m.b.H, Eggelsberg, 
Austria. 

All other mentioned trademarks are property of their respective legal 
owners. 



Safety 16/72 

SmartWire-DT Gateway | EU5C-SWD-POWERLINK  
DOC130802UM02EN | Revision 2 | English | 2013-12 | Released | Public  

2 Safety 
2.1 General Note 

The user manual, all accompanying texts and the documentation are 
written for the use of the products by educated personnel. When using the 
products, all safety instructions, property damage messages and all valid 
legal regulations have to be observed. Technical knowledge is presumed. 
The user has to assure that all legal regulations are obeyed. 

2.2 Intended Use 
The purpose of the EU5C-SWD-POWERLINK Gateway described in this 
user manual is to create a connection between SmartWire-DT slaves and 
an overriding Managing Node (master device) in an Ethernet POWERLINK 
network.  

2.3 Personnel Qualification 
The EU5C-SWD-POWERLINK Gateway must be installed, configured and 
removed by qualified personnel only. Job-specific technical skills for people 
professionally working with electricity must be present concerning the 
following issues: 

 Safety and health at work

 Mounting and connecting of electrical equipment

 Measurement and analysis of electrical functions and systems

 Evaluation of the safety of electrical systems and equipment

 Installing and configuring IT systems

2.4 References Safety  
[S1] ANSI Z535.6-2006 American National Standard for Product Safety Information in 

Product Manuals, Instructions, and Other Collateral Materials 

[S2] IEC 60950-1, Information technology equipment - Safety -  
Part 1: General requirements, 
(IEC 60950-1:2005, modified); German Edition EN 60950-1:2006 

[S3] EN 61340-5-1 and EN 61340-5-2 as well as IEC 61340-5-1 and IEC 61340-5-2 
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2.5 Safety Instructions to Avoid Personal Injury 
To ensure your own personal safety and to avoid personal injury, you must 
read, understand and follow the following safety instructions in this manual 
and all warning messages before you install and operate the EU5C-SWD-
POWERLINK Gateway. 

2.5.1 Electrical Shock Hazard 
Take care of the following safety measures before installing or uninstalling 
the gateway: 

 First disconnect the power plug of the device.

 Make sure that the device is disconnected from the power supply.

 Cover or enclose neighboring units that are live.

Devices that are designed for mounting in housings or control cabinets 
must only be operated and controlled after they have been installed with 
the housing closed. Desktop or portable units must only be operated and 
controlled in enclosed housings. 

2.5.2 Danger of Unintended Starting Up of Machines 
 Install automation devices and related operating elements in such a way

that they are well protected against unintentional operation.

 Emergency stop devices complying with IEC/EN 60204-1 must be
effective in all operating modes of the automation devices. Unlatching
the emergency-stop devices must not cause restart.

 You must take safety precautions (emergency switching off) in the
external circuitry of the EU5C-SWD-POWERLINK and any power
modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To
do so, plan to switch off the power supply to the contactor coils AUX.

 Measures should be taken to ensure the proper restart of programs
interrupted after a voltage dip or failure. This should not cause
dangerous operating states even for a short time. If necessary,
emergency stop devices should be implemented.

 Wherever faults in the automation system may cause damage to
persons or property, external measures must be implemented to ensure
a safe operating state in the event of a fault or malfunction (for example,
by means of separate limit switches, mechanical interlocks etc.).
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2.6 Safety Instructions to Avoid Property Damage 
To avoid damage to your EU5C-SWD-POWERLINK Gateway or your 
communication system, you must read, understand and follow the following 
safety instructions and all safety instructions and warnings in this manual 
concerning property damage, before you install and operate the gateway. 

2.6.1 General Safety Instructions Concerning Supply Voltage 
 In safety-relevant applications the power supply providing power to the

SmartWire-DT system must feature a PELV power feed module
(protective extra low voltage).

 Switch off the power supply if you are reconnecting slaves in the
SmartWire-DT system or reconnecting the ribbon cable connection.
Otherwise the SmartWire-DT slaves can be destroyed!

 The gateway has protection against polarity reversal for the 24-V-DC-
POW supply. However, if the gateway is connected via the serial
interface to an earthed device (for example to a PC), the gateway can be
destroyed, if the polarity of the power supply is reversed!

 The functional earth (FE) must be connected to the protective earth (PE)
or to the potential equalization. The system installer is responsible for
implementing this connection.

 Connecting cables and signal lines should be installed so that inductive
or capacitive interference does not impair the automation functions.

 Suitable safety hardware and software measures should be
implemented for the I/O interface so that a line or wire breakage on the
signal side does not result in undefined states in the automation devices.

2.6.2 Device Destruction by Exceeding Allowed Supply Voltage 
The EU5C-SWD-POWERLINK Gateway must only be operated with the 
specified supply voltage. 

 Make sure that the limits of the allowed range for the supply voltage are
not exceeded. A supply voltage above the upper limit can cause severe
damage of the gateway!

 A supply voltage below the lower limit can cause malfunction of the
gateway!

 Ensure a reliable electrical isolation of the low voltage for the 24 volt
supply. Only use power supply units complying with IEC 60364-4-41
(VDE 0100 Part 410) or HD 384.4.41 S2.

The allowed range for the supply voltage is indicated in the Technical Data 
EU5C-SWD-POWERLINK Gateway section on page 67. 
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2.6.3 Electrostatic Sensitive Device 
The EU5C-SWD-POWERLINK Gateway is sensitive to electrostatic 
discharge, which can cause internal damage and affect its normal 
operation. Therefore adhere to the necessary safety precautions for 
components that are vulnerable to electrostatic discharge when you install 
or remove the gateway. Follow the guidelines listed hereafter when you 
handle the gateway: 

 Touch a grounded object to discharge potential static before you handle
the gateway.

 Wear an approved grounding wrist strap.

 If possible, use a static-safe workstation.

 When not in use, store the device in appropriate static-safe packaging.
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2.7 Labeling of Safety Messages 
In this document, the safety instructions and property damage messages 
are designed according both to the internationally used safety conventions 
as well as to the ANSI Z535 standard. 

 The Section Safety Messages at the beginning of a chapter are
pinpointed particularly. They are highlighted by a specific safety symbol
and a signal word according to the degree of endangerment. In the
safety message, the nature of the hazard is indicated.

 The Integrated Safety Messages embedded in operating instructions
are highlighted by a signal word according to the degree of
endangerment and possibly by a safety symbol. In the safety message,
the nature of the hazard is indicated.

Safety 
symbol 

Sort of warning or principle 

Warning of personal injury or property damage 

Warning of damages by electrostatic discharge 

Principle: Disconnect the power plug 

Table 7: Safety Symbols and Sort of Warning or Principle 

Signal word Meaning Meaning USA 
Indicates a direct hazard with high 
risk, which will have as consequence 
death or grievous bodily harm if it is 
not avoided. 

Indicates a hazardous situation which, if not 
avoided, will result in death or serious injury. 

Indicates a possible hazard with 
medium risk, which will have as 
consequence death or (grievous) 
bodily harm if it is not avoided. 

Indicates a hazardous situation which, if not 
avoided, could result in death or serious 
injury. 

Indicates a minor hazard with 
medium risk, which could have as 
consequence personal injury, if it is 
not avoided. 

Indicates a hazardous situation which, if not 
avoided, may result in minor or moderate 
injury. 

Indicates a property damage 
message. 

Indicates a property damage message. 

Note Indicates an important note in the 
manual. 

Indicates an important note in the manual.  

Table 8: Signal Words 



Descriptions and Requirements 21/72 

SmartWire-DT Gateway | EU5C-SWD-POWERLINK  
DOC130802UM02EN | Revision 2 | English | 2013-12 | Released | Public  

3 Descriptions and Requirements 
3.1 Device Description EU5C-SWD-POWERLINK Gateway 

3.1.1 Function 
The EU5C-SWD-POWERLINK Gateway integrates a SmartWire-DT 
network into an Ethernet POWERLINK network. The Gateway creates a 
data connection between the participants (the slave devices) of the 
subordinate SmartWire-DT network and the Managing Node (the master 
device or PLC) of the super ordinate POWERLINK network. 

The gateway acts as master in the SmartWire-DT network on the one hand, 
and on the other hand as modular Controlled Node (slave device) in the 
POWERLINK network. It thereby presents each connected SmartWire-DT 
participant as individual module to the POWERLINK Managing Node. 

The cyclic process data is exchanged transparently between both 
networks. 1000 Bytes of process input/output data can in sum be 
exchanged with up to 99 SmartWire-DT participants (slaves). 

Figure 1: Data Flow EU5C-SWD-POWERLINK Gateway 
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3.1.2 Configuration 
There are three types of configurations that are relevant for commissioning 
and operating the EU5C-SWD-POWERLINK gateway.  

The actual configuration is the current actual constellation of the devices 
at the SmartWire-DT bus connected to the SmartWire-DT interface of the 
gateway. It is always scanned after each restart of the gateway. This 
procedure can not be influenced. 

In case the actual configuration complies with the configuration envisaged 
for operation, the actual configuration can be captured as target 
configuration and stored zero-voltage safe in the device. This capturing 
and storing of the actual configuration as target configuration can be 
achieved either by pressing the configuration button located at the front 
panel of the gateway or by using the SWD-Assist software (for the position 
of the configuration button, see Device Picture section on page 27).  

This target configuration is then available within the gateway even after 
power-off or restart of the device. If a target configuration has been stored, 
the gateway checks on each restart whether the actual configuration 
complies with the target configuration. In case the gateway detects 
inadmissible deviations, it will not go into operation. If the actual 
configuration deviates from the target configuration because of a device 
failure or removal on the SWD bus, the SWD LED on the gateway starts to 
blink red (for the position of the SWD LED, see Positions of the LEDs 
section on page 28). 

If no errors are detected, the gateway is in principle ready for operation, but 
remains in waiting until the so-called planned configuration is downloaded 
to the gateway via the SWD-Assist software. 

Without a target configuration, the gateway will not go into operation. The 
target configuration therefore has to be generated  

 when you commission the gateway for the first time,

 after replacing a SmartWire-DT slave or

 after deliberately changing the setup of the SmartWire-DT network in
any other way.

The third configuration is the planned configuration (in this document also 
called project configuration). It is created by using the SWD-Assist 
software and contains the desired configuration and the parameters of the 
SmartWire-DT network. It can be manually created in SWD-Assist by 
adding the individual device symbols in the “workbench” window, or it can 
be automatically created by taking over (i. e. reading-in) the target 
configuration from the gateway. The latter method is less prone to errors 
and therefore recommended.  

The project configuration has to be complemented in SWD-Assist with the 
device-specific parameters of the SWD slaves and the POWERLINK-
specific parameters (i. e. the node ID of the gateway). It then has to be 
downloaded from the configuration PC to the gateway via USB, where it is 
stored (like the target configuration) zero voltage-safe in the flash memory 
of the device. 
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The gateway checks the project configuration against the target 
configuration after each restart. SWD-Assist lets you define individual SWD 
slaves in the project configuration as being “non-mandatory” (which means 
that these slaves are allowed to be missing in the target configuration). 
Thus project configuration and target configuration must not necessarily 
comply with each other, but must be compatible. The result of this checking 
is indicated by the Config LED on the gateway (for the position of the 
Config LED, see Positions of the LEDs section on page 28). 

In order to acquaint the gateway with the POWERLINK Managing Node 
within its POWERLINK configuration, you have to generate an XDD device 
description file out of the project configuration in SWD-Assist, and then and 
export it. This file contains the projected/planned configuration of the 
gateway in a standardized description format, which complies with general 
POWERLINK specifications. The XDD file then has to be imported into your 
POWERLINK engineering tool (e. g. Automation Studio by B & R). 
Afterwards, you can add the gateway in the engineering tool to an already 
existing POWERLINK project as Controlled Node and perform a data 
mapping for the contained I/O modules (i. e. the SmartWire-DT slaves). 
Finally, you can load the project onto your POWERLINK Managing Node. 
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3.1.3 Interfaces 
The gateway features a SmartWire-DT interface (plug, 8-pole), a 2-port 
switch Ethernet interface (RJ45) and a Mini-USB interface. Via the Mini-
USB interface, the gateway can be accessed, configured and diagnosed 
with the SWD-Assist software. 

3.1.4 Diagnosis 
The gateway can be diagnosed by connecting the SWD-Assist software to 
the Mini-USB interface. For further information, please refer to the SWD-
Assist online help. 

The POWERLINK protocol also provides diagnostic functions. For further 
information, see Diagnosis/Status Response section on page 61. 

3.1.5 Firmware and Device Description File 
The EU5C-SWD-POWERLINK Gateway is shipped with its most recent 
firmware already loaded. Which firmware version is loaded in the gateway 
at the time of delivery can be inferred from the device type label (see 
Device Type Label section on page 32). 

You can update the firmware from your configuration PC by using an 
ordinary web browser.  
A web server embedded in the gateway provides a special web page for 
updating the firmware. This web server can be accessed via the Ethernet 
interface of the Gateway. For more details on this, please refer to the 
Updating Firmware chapter on page 62 ff. 

A device description file in XDD format can be generated by the SWD-
Assist software. It can then be imported into a POWERLINK engineering 
tool (like e. g. Automation Studio by B & R). 
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3.2 Prerequisites for Operation 
The following prerequisites must be fulfilled to operate the EU5C-SWD-
POWERLINK Gateway: 

3.2.1 Network Systems 
 SmartWire-DT network with maximum number of up to 99

participants/stations/slaves and maximum extension of up to 600
meters.

 Ethernet POWERLINK network with POWERLINK PLC (Managing
Node). Maximum cable length for one segment (i. e. cable between two
devices or hubs) is 100 meters.

3.2.2 Power Supply 

In safety-relevant applications the power supply providing power for the 
SmartWire-DT system must feature a PELV power feed module 
(protective extra low voltage). 

Ensure a reliable electrical isolation of the low voltage for the 24 volt 
supply. Only use power supply units complying with IEC 60364-4-41 
(VDE 0100 Part 410) or HD 384.4.41 S2. 

You must take safety precautions (emergency switching off) in the 
external circuitry of the EU5C-SWD-POWERLINK and any power 
modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are used. To 
do so, plan to switch off the power supply to the contactor coils AUX. 

Important!  
Please take into consideration the total power consumption of your 
SmartWire-DT network and, if necessary, plan for an additional feeder 
module EU5C-SWD-PF2. 
You can find information on the power consumption in the operating 
manuals of the SmartWire-DT devices. 
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3.2.2.1 POW Power Connection 

A Power supply of 24 V DC for the coupling unit and for the Smart-Wire-DT 
slave electronics is needed at the connection POW. 

On the SmartWire-DT gateway, connect the POW and AUX supply 
voltages via separate miniature circuit-breakers or fuses: 

Miniature circuit-breaker 24 V DC for POW 

 Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip
types C or Fuse 3 A, utilization class gL/gG

 Cable protection for cable AWG 24 in accordance with UL 508 und CSA-
22.2 No. 14:
Miniature circuit-breaker 24 V DC rated operational current 3 A; Tripping
characteristics C or Fuse 3 A

3.2.2.2 AUX Power Connection 

If any switching devices are also to be connected, for example via the DIL-
SWD-32-001/002 SmartWire-DT slaves, a 24 V DC supply will also be 
required at the AUX power connection. This provides the supply for 
activating the contactor coils. This supply must be protected by an 
automatic circuit-breaker (3A gG/gl or 3 A miniature circuit-breaker with a Z 
characteristic).  
If switching devices with an activation power greater than 3 A are 
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-
PF2 must be used. 

On the SmartWire-DT gateway, connect the POW and AUX supply 
voltages via separate miniature circuit-breakers or fuses: 

Miniature circuit-breaker 24 V DC for AUX 

 Cable protection in accordance with DIN VDE 0641 Part 11, IEC/EN
60898:
Miniature circuit-breaker 24 V DC rated operational current 3 A; trip type
Z or Fuse 3 A, utilization class gL/gG

 Cable protection for cable AWG 24 in accordance with UL 508 und CSA-
22.2 No. 14:
Miniature circuit-breaker 24 V DC rated operational current 2 A; Tripping
characteristics Z or Fuse 2 A
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4 Device Picture, Connectors and LEDs 
4.1 Device Picture 

24 V power supply POW 

Ethernet POWERLINK interface 
(RJ45) 

LEDs communication status 
POWERLINK  
(see subsequent section for details) 

Mini-USB interface 

Configuration button 

LEDs Gateway functions 
(see subsequent section for details) 

24 V power supply AUX 

SmartWire-DT connection  
(plug, 8-pole) 

Figure 2: Front View EU5C-SWD-POWERLINK Gateway 
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4.2 Positions and Meaning of the LEDs 

4.2.1 Positions of the LEDs 
POW: System status 

APL: Application status 

Config.: Configuration status 

SWD: SmartWire-DT status 

BS: POWERLINK bus status  

BE: POWERLINK bus error 

L/A: LINK/Activity for channel 0 

Receive/Transmit (RX/TX) for channel 0 

L/A: LINK/Activity for channel 1 

Receive/Transmit (RX/TX) for channel 1 

Figure 3: LEDs EU5C-SWD-POWERLINK Gateway 
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4.2.2 Descriptions of the LEDs 

LED Color State Meaning 
Duo-LED yellow/green 

 (yellow) On Bootloader netX (= rom loader) is waiting for Second Stage 
Bootloader. 

(green/yellow) 
Flashing 
green/yellow 

Second Stage Bootloader is waiting for firmware. 

 (green) On Operating system running, firmware is started. 

POW 
System 
status 

Number in 
picture:  

 (off) 
Off Power supply for device is missing or hardware is defect. 

Duo-LED red/green 

 (green) On Communication on POWERLINK and SmartWire-DT is in cyclic data 
exchange and the gateway function is executed. 

 (green) 
Flashing  
1 s off,  
1 s on 

Gateway is initialized, but the communication on POWERLINK and 
SmartWire-DT is not in cyclic data exchange. 

 (red)  
Flashing  
1 s off,  
1 s on 

Gateway is initialized, but the SmartWire-DT configuration is 
missing or in error. 

APL 
Application 
status 

Number in 
picture:  

 (red) 
On Gateway has detected an error during the initialization: Missing 

configuration, error in configuration or internal error. 

Duo-LED red/green 

 (green) On The project configuration complies with the target configuration. 
Data exchange between gateway and PLC via POWERLINK is 
possible. 

 (green) Flashing  The project configuration does not comply with the target 
configuration, but is compatible with it.  
Data exchange between gateway and PLC via POWERLINK is 
possible. 

 (red) On The project configuration and the target configuration are not 
compatible. 
Data exchange between gateway and PLC via POWERLINK is not 
possible. 

Config. 
Configuration 
status 

Number in 
picture: 

 (off) 
Off No communication with the POWERLINK PLC, or the gateway does 

not have a project configuration. 

Table 9: Description of the LEDs (1) 
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LED Color  State Meaning 
Duo-LED red/green/orange (orange = red/green at same time) 

 (green) On The actual configuration complies with the target configuration. 
Data exchange between gateway and SmartWire-DT slaves takes 
place. 

 (red) Flashing  The gateway misses its target configuration 
or a necessary SmartWire-DT slave is missing  
or the target configuration does not comply with the actual 
configuration. 
No data exchange between gateway and SmartWire-DT slaves. 

 (green) 
Flashing  Slave addressing is active (after power-on or download of a project 

configuration containing empty modules). 
No data exchange between gateway and SmartWire-DT slaves. 

 (red) On Short-circuit on the 15 V power supply or no SmartWire-DT slave is 
connected. 
No data exchange between gateway and SmartWire-DT slaves. 

SWD 
Status 
SmartWire-DT 

Number in 
picture: 

 (orange) 
Flashing After having pressed the configuration button: The gateway reads 

the actual configuration and stores it as target configuration. 

Duo-LED red/green 

 (off) 
Off Controlled Node (gateway) is initialized 

Flickering Controlled Node (gateway) is in basic Ethernet state 

Single Flash Controlled Node (gateway) is in state “Pre-Operational 1” 

Double Flash Controlled Node (gateway) is in state “Pre-Operational 2” 

Triple Flash Controlled Node (gateway) is in state “ReadyToOperate” 

On Controlled Node (gateway) is in state “Operational” 

BS 
POWERLINK 
Bus Status 

Number in 
picture: 

 (green) 

Blinking Controlled Node (gateway) is in state “Stopped” 

Duo-LED red/green 

 (off) 
Off No error

BE 
POWERLINK 
Bus Error 

Number in 
picture: 

 (red) On Controlled Node (gateway) has detected an error 

LED green 

 (green) On Link: Gateway has connection to Ethernet 

 (green) 
Flashing  Activity: Gateway sends/receives Ethernet frames 

L/A (RJ45) 
Ch0 & Ch1 

Numbers in 
picture: 

 & 
 (off) 

Off Gateway has no connection to Ethernet 

LED yellow (RJ45)  
Ch0 & Ch1 

Numbers in 
picture: 

 & 

 (yellow) - This LED is not used 

Table 10: Description of the LEDs (2) 
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4.3 Pinning POWERLINK Interface 
The following picture shows the pinning of the Real-Time Ethernet interface 
of the Gateway: 

Figure 4: Pinning of the Ethernet Interface (RJ45) 

Pin Signal Description 
1 TX + Transmit Data + 

2 TX –  Transmit Data – 

3 RX + Receive Data + 

4 TERM 

5 TERM 
Bob Smith Termination 

6 RX – Receive Data – 

7 TERM 

8 TERM 
Bob Smith-Termination 

Table 11: Ethernet Interface Channel 0 and Channel 1 Pin Assignment (RJ45) 

Note: The Ethernet interface supports Auto-Crossover. 
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4.4 Device Type Label 
The EU5C-SWD-POWERLINK Gateway is equipped with a device type 
label, which provides the following information: 

Version of firmware (at time of 
delivery) 

Information on power supply for 
switching devices (AUX) 

Information on power supply for 
Gateway and Smart-Wire-DT 
slaves (POW) 

Information on wire gauge of 
power supplies 

Operating ambient temperature 

Device type name 

Part number 

Hardware revision number 

Serial number 

Figure 5:Device Type Label EU5C-SWD-POWERLINK Gateway 
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5 Getting Started 
The following table provides an overview of the steps necessary for 
installing and commissioning the EU5C-SWD-POWERLINK Gateway. 

# Step For details see 
1 Install gateway Chapter Installing Gateway on page 34 

1.1 Take safety precautions  Section Safety Messages on page 34 

1.2 Mount gateway onto top hat rail Section Mounting Gateway onto Top 
Hat Rail on page 35 

1.3 Connect gateway to power supply Section Connecting Gateway to Power 
Supply on page 38 

1.4 Connect gateway to SmartWire-DT network Section Connecting SmartWire-DT on 
page 40 

2 Configure gateway Chapter Configuring Gateway on page 
42 

2.1 Configure SmartWire-DT network in gateway Section Configuring SmartWire-DT 
network in Gateway on page 42  

2.2 Install SWD-Assist and USB driver on configuration 
PC 

Section Installing SWD-Assist and USB 
Driver on Configuration PC on page 44 

2.3 Connect configuration PC to gateway via USB Section Connecting Gateway to 
Configuration PC via USB on page 46 

2.4 Configure gateway project in SWD-Assist 

2.5 Download project configuration to gateway 

Section Configuring Gateway in SWD-
Assist (Creating Project Configuration) 
on page 47 

3 Configure gateway in POWERLINK Chapter Configuring Gateway in 
POWERLINK on page 53 

3.1 Create XDD device description file for gateway in 
SWD-Assist 

3.2 Import XDD device description file in POWERLINK 
engineering tool 

3.3 Configure gateway in POWERLINK engineering 
tool 

3.4 Download POWERLINK configuration to PLC 

Chapter Configuring Gateway in 
POWERLINK on page 53 

3.5 Connect gateway to POWERLINK network Section Connecting POWERLINK on 
page 41 

Table 12: Getting Started 
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6 Installing Gateway 
6.1 Safety Messages 

Please observe the following safety messages when you install and 
handle the gateway! 

 First disconnect the power plug of the device.

 Make sure that the power supply is off at the device.

 Cover or enclose neighboring units that are live.

Electrostatic Sensitive Device 

The gateway is sensitive to electrostatic discharge, which can cause 
internal damage and affect its normal operation. Therefore adhere to the 
necessary safety precautions for components that are vulnerable to 
electrostatic discharge, when you install or handle the gateway. 

 Do not touch the metal pins of the connectors of the gateway.

 Touch a grounded object to discharge potential static.

 Wear an approved grounding wrist strap.

 If available, use a static-safe workstation.

 When not in use, store the device in an appropriate static-safe
packaging.
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6.2 Mounting Gateway 
No tools are required for mounting the EU5C-SWD-POWERLINK Gateway 
onto a top hat rail. The back of the gateway  carries a spring-fitted bolt , 
by which the gateway can be clamped to the rail . 

Figure 6: Mounting Principle of the Gateway 

6.2.1 Mounting Gateway onto Top Hat Rail 
To mount the gateway onto the top hat rail, proceed as follows: 

 Make sure that the gateway is disconnected from any power supply.

 Cover or enclose neighboring units that are live.

 Tilt the gateway slightly and hook it
into the upper railing from above,
thereby pushing down the gateway
with slight force, in order to
overcome the resistance of the
spring in the bolt.

Figure 7: Hook Gateway to Upper 
Railing 
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 Keep on pushing the gateway
downwards and tilt it back into
vertical position, thereby hooking
the gateway into the lower railing.

Figure 8: Hook Gateway to Lower 
Railing 

 Let go of the gateway. The spring
inside the bolt automatically pushes
the gateway upwards into the
railings, thereby fixing the gateway
to the top hat rail.

Figure 9: Gateway is Clamped to 
Top Hat Rail  
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6.2.2 Removing Gateway from Top Hat Rail 
To remove the gateway from the top hat rail, proceed as follows: 

 First disconnect the power plugs from the gateway.

 Make sure that the power supply is off at the gateway.

 Cover or enclose neighboring units that are live.

 Push down the gateway with slight
force (to overcome the resistance of
the spring in the bolt), then unhook
the gateway first from the lower
railing and then from the upper
railing.

Figure 10: Unhook Gateway 
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6.3 Connecting Gateway to Power Supply 

Danger of lethal injuries by unexpected starting up of motors or 
machinery! 
If you have already integrated devices into a system, secure the operating 
range of any connected parts of the system against access, so that 
nobody is endangered by motors or machinery starting up unexpectedly. 

In safety-relevant applications, the power supply providing power to the 
SmartWire-DT system must feature a PELV power feed module 
(protective extra low voltage). 

You must take safety precautions (emergency switching off) in the 
external circuitry of the EU5C-SWD-POWERLINK Gateway and any 
power modules type EU5C-SWD-PF1-1 or EU5C-SWDPF2-1 that are 
used. To do so, plan to switch off the power supply to the contactor coils 
AUX. 

Important!  
Please take into consideration the total power consumption of your 
SmartWire-DT network and, if necessary, plan for an additional feeder 
module EU5C-SWD-PF2. 
You can find information on the power consumption in the operating 
manuals of the SmartWire-DT devices. 

 Connect the 24 V DC voltage to the POW terminals on the front side of
the gateway. The POW connection provides the voltage for the gateway
itself and for the SmartWire-DT slave electronics.

Note: For the 15 V supply of the SmartWire-DT slaves, the gateway 
contains an additional power feed module with an amperage of 0.7 A. 
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 If necessary, connect the 24 V DC voltage for the contactor coils to the
AUX terminals on the front side of the gateway.

Figure 11: Gateway Power Supply  

Note: The AUX supply is required if any switching devices are also to be 
connected, for example, via the DIL-SWD-32-001/002 SmartWire-DT 
slaves. The AUX connection provides the supply for activating the 
contactor coils. 
This supply must be protected by an automatic circuit-breaker (3A gG/gl or 
3 A miniature circuit-breaker with a Z characteristic). 
If switching devices with an activation power greater than 3 A are 
connected, an additional feeder module EU5C-SWD-PF1 or EU5C-SWD-
PF2 must be used. 

Potential conditions between the components  
The entire SmartWire-DT system operates on a common supply voltage. 
Provide a common star point for the earth wiring. In this way, the various 
slaves in the SmartWire-DT system will not be electrically isolated from one 
another.  
The POWERLINK network and the SmartWire-DT system are electrically 
isolated from one another. 
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6.4 Connecting SmartWire-DT 
 Connect the SmartWire-DT network to the gateway. To do so, use the

SmartWire-DT cable SWD4-100LF8-24 and the SWD4-8MF2 relevant
blade terminal or prefabricated cables of type SWD4-(3/5/10)F8-24-2S.

Figure 12: Connecting SmartWire-DT to Gateway  

Switch off the power supply, if you are reconnecting slaves in the 
SmartWire-DT system or reconnecting the ribbon cable connection. 
Otherwise the SmartWire-DT slaves can be destroyed! 

Note: Detailed instructions on adapting the SmartWire-DT external device 
plug (SWD4-8SF2-5) to the 8 pole Smart-Wire-DT cable are provided in 
chapter Fitting external device plugs SWD4-8SF2-5 of the manual 
SmartWire-DT – The System, MN05006002Z-EN (previously AWB2723-
1617en). 
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6.5 Connecting POWERLINK 
 Connect the RJ45 plug of the POWERLINK cable to one of the Ethernet

connectors on the gateway.

Figure 13: Connecting POWERLINK to Gateway 

Important!  
Please observe the following notes on POWERLINK cabling: 

 Use only hubs, no switches.

 Maximum cable length in a segment (allowed space between
individual devices/hub) is 100 meters.

6.6 EMC-Conformant Wiring of the Network 
Undesired faults can occur on the bus due to electromagnetic interference. 
This can be minimized beforehand by the implementation of suitable EMC 
measures. These include: 

 EMC-conformant system configuration,

 EMC compliant cable routing,

 Measures that do not allow the occurrence of large differences in
potential and

 correct installation of the POWERLINK system (cables, connection of
the bus connectors, etc.)

The effects of electromagnetic interference can be significantly reduced by 
fitting a shield.  

For more detailed information on this, please refer to the IAONA Industrial 
Ethernet -Planning and Installation Guide by IAONA e.V. Magdeburg, 
Germany. 
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7 Configuring Gateway 
For data exchange between the gateway and the POWERLINK Managing 
Node, the gateway needs valid target and project configurations of the 
SmartWire-DT network. This chapter describes how to create and store 
these configurations in the gateway. 

7.1 Configuring SmartWire-DT network in Gateway (Creating 
Target Configuration) 

When you commission the gateway, you have to read-in the actual 
configuration of the SmartWire-DT network (i. e. the line-up of the 
participants/devices connected to the SWD bus) and store it as target 
configuration. 

Reading and storing the SmartWire-DT network configuration takes place 
by pressing the configuration button on the gateway (for the position of the 
configuration button, see figure Front View EU5C-SWD-POWERLINK 
Gateway on page 27). All SmartWire-DT slaves are re-addressed in 
ascending order by this process. As an alternative, you can generate and 
store the target configuration by using the SWD-Assist software (the 
gateway must be connected to SWD-Assist via USB). 

This process should only take place in the case of: 

 initial commissioning,

 replacement of a defective slave or

 deliberate change to the configuration.

Important!  
If there is a faulty configuration and the configuration button is pressed, 
only the slaves up to the failed device are addressed and stored. Use of 
the remaining slaves is not possible until the defective slave has been 
replaced and the configuration has been read-in again by pressing the 
configuration button. 

The remanently stored target configuration is compared with the current 
configuration (actual configuration) each time the gateway is restarted and 
during bus operation. If the gateway recognizes that a required SmartWire-
DT slave cannot be reached or a wrong slave type is determined, the 
gateway will not go into operation or stops operating. This depends in each 
case on the setup of the network which has been defined in the 
planned/project configuration. In case of error, the SmartWire-DT status 
LED (SWD LED) starts to blink in red (for the position of the SWD LED, see 
Positions of the LEDs section on page 28).  

If a SmartWire-DT slave has failed, the SmartWire-DT network can still be 
operated with the remaining slaves, depending on the settings in the 
planned/project configuration (even after a repeated power up of the 
gateway). The failure is reported to the application. 
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Prerequisites for reading-in the SmartWire-DT configuration are: 

 All SmartWire-DT slaves are connected to the SmartWire-DT line.

 The SmartWire-DT network is connected to the gateway.

 The voltage POW is applied to the gateway and the power LED POW is
on.

 The voltage AUX is applied (if necessary).

 The SmartWire-DT status LEDs of the individual SmartWire-DT slaves
are on or are flashing.

 The POWERLINK network is disconnected from the gateway by
removing the RJ45 plug from the Ethernet interface of the gateway.

To read-in the SmartWire-DT configuration proceed as follows: 

 Make sure that POWERLINK is disconnected from the gateway.

 Press the configuration button on the gateway for at least two seconds
(for the position of the configuration button, see figure Front View
EU5C-SWD-POWERLINK Gateway on page 27).

Note: Take care to push-in the button properly. You have to feel and 
overcome a slight resistance at the end when pushing the button into the 
gateway, otherwise the button won’t trigger. 

 The SmartWire-DT status LED (SWD LED) on the gateway begins to
flash orange. The SmartWire-DT status LEDs on the SmartWire-DT
slaves also flash. All slaves are addressed in sequence, the complete
configuration is stored retentively as gateway target configuration.

 The SmartWire-DT status LED (SWD LED) on the gateway shows
steady green.
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7.2 Installing SWD-Assist and USB Driver on Configuration 
PC  

You need the SWD-Assist software on your configuration PC in order to 
create, parameterize and download a project configuration to the gateway. 
With SWD-Assist, you can also perform a diagnosis of the SmartWire-DT 
network and create an XDD device description file, which can imported into 
your POWERLINK engineering tool for the purpose of configuring the 
POWERLINK Managing Node. 
In the installation wizard of the SmartWire-DT Gateway Solutions DVD, you 
can install the version of the SWD-Assist software delivered on the DVD, or 
you can choose to be directed to an internet website from which you can 
download the latest version of SWD-Assist (if available). 

In order to establish an USB connection between SWD-Assist and the 
gateway, you also need to install the USB driver on your configuration PC. 
An installation program for the USB driver is delivered on the SmartWire-DT 
Gateway Solutions DVD. It contains all components needed for the 
installation of the driver under Windows XP, Windows Vista, Windows 7 
and Windows 8. It detects whether the 32 bit or the 64 bit version of the 
driver needs to be installed. 
It is recommended to use the installation program to install the USB driver. 
It is also recommended to install the USB driver before you connect the 
gateway to your configuration PC via USB for the first time (“software first” 
principle). 

Step-by-step Instructions 
To install the software on your configuration PC, proceed as follows: 

 Insert the SmartWire-DT Gateway Solutions DVD into your local DVD-
ROM drive.

 If the “Auto Play” function of your Windows PC is enabled, the start
screen of the DVD is displayed.

Note: As an alternative, you can also open the start screen of the DVD by 
double-clicking the SmartWire.exe file in the root directory of the DVD. 

 In the menu of the start screen, click Install Planning and
Configuration Tools.
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 The SmartWire-DT Installation Wizard opens:

Figure 14: SmartWire-DT Installation Wizard 

Note: The wizard automatically checks for already installed software 
components (which e. g. might have been installed for an earlier project), 
and lists the missing components accordingly. 

 Select the appropriate installation options.

 Read the license agreement, then select License agreement read and
accepted.

 Click Execute, then follow the instructions of the installation program.

Note: Under Windows XP, the installation process of the USB driver is not 
yet finished after having executed the driver setup. 
The installation process has to be completed in the Found New 
Hardware Wizard, which automatically opens when you connect the 
gateway to your configuration PC via USB cable for the first time (see 
following section). 
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7.3 Connecting Gateway to Configuration PC via USB 
 Make sure that the gateway is connected to a voltage supply.

 Connect the Mini USB interface of the gateway with a USB interface of
your configuration PC (for the position of the USB interface on the
gateway, see section Device Picture on page 27).

Windows XP: 
When you connect the gateway via USB for the first time to a PC running 
under Windows XP, the Found New Hardware Wizard opens:  

 Answer the question Can Windows connect to Windows Update…?,
with No, not this time. Then click Next button.

 If you have already carried out the setup of the USB driver (as
recommended), you can ignore the wizard’s request to insert a CD or
floppy disk. Answer the What do you want the wizard to do? question
by selecting the Install the software automatically option, then click
Next button.

 Windows copies the driver files to the Windows directories.

 After the installation is complete, click Finish button.

Windows 7 and 8: 
If you have carried out the setup of the USB driver before first connecting 
the USB cable (as recommended), the installation will automatically be 
finished. Afterwards, the USB connection is instantly operative. 
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7.4 Configuring Gateway in SWD-Assist (Creating Project 
Configuration) 

This section describes how to create and parameterize the project 
configuration (also called planned configuration) in SWD-Assist. This 
project configuration afterwards has to be downloaded to the gateway, in 
order to make it operative.  
You can create the project configuration in SWD-Assist by manually adding 
the individual SWD participants symbols from the device catalog to the 
SWD string in the “workbench” window, or it can be automatically created 
by taking over (i. e. reading-in) the target configuration from the gateway 
(for a description of how to create the target configuration, see Configuring 
SmartWire-DT network in Gateway (Creating Target Configuration) on page 
42). This section describes the easier and faster method of automatically 
taking over the target configuration from the gateway. 

1. Start SWD-Assist.

 In the Windows Start menu, choose All Programs > Eaton > SWD-
Assist.

 The SWD-Assist software opens.

 If the SWD-Assist catalogue selection dialog window appears,
choose Eaton EMEA option and click OK button.

 SWD-Assist opens in the Project View:

Figure 15: Start Window of SWD-Assist 
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2. Create online connection to gateway.

 To change from the Project View to the Communication View, choose
View > Communication View from the menu bar, or click  button in
the icon bar.

 The Communication View opens:

Figure 16: Communication View in SWD-Assist 

Ø In the Interface drop-down list below Connection setup, select the 
COM port of your configuration PC to which you have connected the 
gateway via USB. You can recognize the correct port by the entry next 
to the COM port number (Eaton EU5C-SWD).

Ø Click Online button.
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 SWD-Assist establishes the online connection and reads-in the target
configuration which had been stored in the gateway. The SWD devices
belonging to the target configuration are depicted as blue symbols
connected to the SWD bus:

Figure 17: Target Configuration in SWD-Assist 

Note: If no target configuration has been stored in the gateway yet, you 
can create it now by clicking the Renew button in the Target 
configuration area in the left window. Thereby, the actual configuration 
(i. e. the current line-up of the devices connected to the SmartWire-DT 
network) is read-in, stored as target configuration in the gateway and 
transferred to SWD-Assist. 

3. Generate project configuration from target configuration.

 In the Target configuration area, click Device => PC button to save
the target configuration from the device in SWD-Assist, in order to adapt
it as project configuration (i. e. planned configuration).

 Answer the security question with Yes.

 In the Connection setup area, click Offline button.

4. Edit project configuration.

 To change from Communication View back to Project View click
button or press Ctrl+Alt+1 on your keyboard.
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 In the Project View, the former target configuration is now displayed as
project configuration (i. e. planned configuration):

Figure 18: Planned Configuration in SWD-Assist: Set Device Parameters 

 In the Workbench window, select an SWD slave device, then open the
Device Parameters tab in the Properties field window (located below
the Workbench window) and determine whether the device should be a
Required module and whether it Can be replaced with universal
module.
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5. Set POWERLINK parameters in project configuration.

 In the Workbench window, select the EU5C-SWD-POWERLINK
gateway.

Figure 19: Planned Configuration in SWD-Assist: Set POWERLINK Parameters of Gateway 

 Then open the Powerlink parameters tab in the Properties field
window (located below the Workbench window) and enter the Node-
lD, by which the gateway should be reached in the POWERLINK
network.

6. Transfer project configuration to gateway.

 To change from the Project View to the Communication View, choose
View > Communication View from the menu bar, or click  button in
the icon bar.

 The Communication View opens.

 In the Connection setup area of the Communication View, click Online
button.

 SWD-Assist re-establishes an online connection, reads-in the target
configuration from the gateway again and displays it in the Workbench
window.

Note: Before downloading the project configuration, you can let SWD-
Assist compare it with the target configuration stored in the gateway by 
clicking the PC = Device? button in the Target configuration area. 
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 In the Planned configuration area, click PC => Device button to
transfer the project/planned configuration via USB to the gateway.

Note: The project configuration is stored in the gateway along with the 
target configuration. Any old project configuration file that might have 
existed in the gateway up to this point will be overwritten. If an old project 
configuration file exists in the gateway, you can let SWD-Assist compare it 
with the new project configuration by clicking the PC = Device? button in 
the Planned configuration area before downloading the new one. 

 The project configuration is copied to the gateway and stored there non-
volatile. If the project configuration complies with the target
configuration, the Config LED starts to show steady green light after a
few seconds (see also Positions and Meaning of the LEDs section on
page 28).
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8 Configuring Gateway in POWERLINK 
In order to acquaint the gateway with the POWERLINK Managing Node 
within its POWERLINK configuration, you need an XDD device description 
file. This file contains the projected/planned configuration of the gateway in 
a standardized description format, which complies with general 
POWERLINK specifications.  

You can generate the XDD file in SWD-Assist from your project 
configuration and import it into your POWERLINK engineering tool, e. g. 
Automation Studio. There you can add the gateway as Controlled Node to 
an already existing POWERLINK project and perform a data mapping for 
the projected I/O modules (i. e. the SmartWire-DT devices). Afterwards you 
can load the POWERLINK project onto your POWERLINK Managing 
Node. 

1. Generate XDD device description file in SWD-Assist.

 Open the project in SWD-Assist. (If you have just recently copied the
project configuration to the gateway – see preceding section – change
from the Communication View back to the Project View.)

 The Project View shows the project configuration:

Figure 20: Planned Configuration in SWD-Assist 

 In the menu, select Project > Generate XDD file…
 The Save XDD file dialog window opens.

 Choose the directory where you want to store the XDD file and enter a
file name, then click Save.
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2. Import XDD device description file into Automation Studio.

 Open your POWERLINK project in Automation Studio.

 In the menu of Automation Studio, choose Tools > Import Fieldbus
Device…

 A file selection dialog window opens.

 Select the XDD device description file, then click Open.

 The XDD device description file is imported.

3. Add gateway to the POWERLINK project.

 In the right window, select the Managing Node of your POWERLINK
project.

Figure 21: POWERLINK Project in Automation Studio 

 Open the context menu and choose Insert…
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 The Select controller module dialog window opens:

Figure 22: Select Controller Module Dialog in Automation Studio 

 Make sure that the Insert module option is selected.

 Scroll the list for the Gateway XDD entry and select it. After selecting
the entry, click Next.

 The Module Parameter dialog window opens:

Figure 23: Module Parameter Dialog in Automation Studio 

 In the Enter node number field, enter the Node-ID which you have
assigned to the gateway in the project configuration of SWD-Assist.

 Click Next.
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 The Module Parameter dialog window closes and the gateway is
displayed in the POWERLINK project:

Figure 24: Gateway in POWERLINK Project 

4. Map I/O data.

 In the left window, select the gateway.

 Open context menu and select Open I/O Mapping.

Figure 25: Open I/O Mapping 
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 In the right window, a list featuring the in- and outputs of the
SmartWire-DT slaves opens:

Figure 26: I/O Mapping of SWD Slaves 

 Link the I/O data to variables.

 Save the project.

5. Load POWERLINK project to PLC via Ethernet.

 In the menu, choose Project > Transfer To Target to compile the
project and load it onto the POWERLINK PLC.

 The project is compiled and loaded to the PLC
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9 POWERLINK Data Communication 
9.1 Acyclical Communication 

The POWERLINK Managing Node can exchange acyclic data with 
individual SmartWire-DT slaves via the gateway and the Object Index 
0x3000. For SDO Write (acyclic output), i. e. for writing data to a SWD 
slave (e. g. a read request), the Sub-Index 1 is provided. For SDO Read 
(acyclic input), i. e. for reading requested data from a SWD slave, the Sub-
Index 2 is provided. 

9.1.1 SDO Write (Acyclic Output) 

9.1.1.1 Read Request 

Elements SDO Write – Read Request 
For writing a read request, use Object Index 0x3000 together with Sub-
Index 1 and the following elements:  

Element Description Data type Value range Value 
example 

Value 
example 
in hex 

Slave Address Address of the SWD slave that you want to 
read (i. e. the address defined in the project 
configuration)  

uint8 1…99 5 0x05 

SWD Index SWD-specific index of the SWD slave. 
Determines what kind of data you want to 
read, e. g. error counter or firmware 
version. 

uint8 0…255 127 0x7F 

Request Type Type of request: Read or Write Request.  
A read request must have the value 0 

uint8 Read  
Request = 0 

Write 
Request = 1 

0 0x00 

Length Maximum length of the expected response 
(in bytes) 

uint8 1…120 120 0x78 

Table 13: Elements Read Request SDO Write 

Example of SDO Write – Read Request 
In case the POWERLINK Managing Node wants to read the error counter 
(SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), and the 
expected response should not be longer than 120 Bytes, the SDO Write 
sent to the gateway must feature the following values: 

Syntax 
Elements Object Index Sub-Index 

Slave Address SWD Index Request Type Length 

0x3000 0x01 0x05 0x7F 0x00 0x78

Table 14: Example Read Request SDO Write 
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9.1.1.2 Write Request 

Elements SDO Write – Write Request 
For writing a write request to the SmartWire-DT slave, use Object Index 
0x3000 together with Sub-Index 1 and the following elements:  

Element Description Data type Value range Value 
example 

Value 
example 
in hex 

Slave Address Address of the SWD slave (i. e. the address 
defined in the project configuration)  

uint8 1…99 5 0x05 

SWD Index SWD-specific index of the SWD slave. 
Determines where you want write data. 

uint8 0…255 127 0x7F 

Request Type Type of request: Read or Write Request.  
A write request must have the value 1 

uint8 Read  
Request = 0 

Write 
Request = 1 

1 0x01 

Length Length of the data to be written (in bytes) uint8 1…120 1 0x01 

Data Data to be written uint8 (…) 0 0x00 

Table 15: Elements Write Request SDO Write 

Example of SDO Write – Write Request 
In case the POWERLINK Managing Node wants to reset the error counter 
(SWD Index 127) of the 5th SmartWire-DT slave (slave address 5), the 
SDO Write sent to the gateway must feature the following values: 

Syntax 
Elements Object Index Sub-Index 

Slave Address SWD Index Request Type Length Data 

0x3000 0x01 0x05 0x7F 0x01 0x01 0x00

Table 16: Example Write Request SDO Write 
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9.1.2 SDO Read (Acyclic Input) 

Elements SDO Read 
The requested data can be read by using Object Index 0x3000 together 
with Sub-Index 2. The response features the following elements: 

Element Description Data 
type 

Value range Value 
example 

Value 
example in 
hex 

Slave Address Address of the SWD slave of 
which data has been read. 

uint8 1…99 5 0x05 

SWD Index SWD index of the data which 
has been read, e. g. error 
counter or firmware version. 

uint8 0…255 127 0x7F 

Request Type Type of request.  
A read request has the value 0 

uint8 Read Request = 0 

Write Request = 1 

0 0x00 

Length Length of the received 
response in bytes 

uint8 1…120 120 0x78 

Data Actual data which has been 
read according to SWD Index, 
e. g. error counter or firmware
version.

uint8 
[120] 

(…) (…) (…) 

State State of the response uint8 Idle = 0 
In progress = 1 
Finished = 2 
Error = 3 

2 0x02 

Error Code Error detected by the SWD 
master (i. e. by the gateway) 

uint32 No error  
= 0x00000000 

JOBID_BUFFER_FULL
= 0xC0AD0002 

JOB_DENIED 
= 0xC0AD0003 

NOT_AVAILABLE 
= 0xC0AD0004 

0 0x00 

Table 17: Elements SDO Read 

Example SDO Read 
In case the response is finished and no error was detected, the SDO Read 
(which is sent back by the gateway to the Managing Node in order to 
answer the SDO Write) features the following values: 

Syntax 
Elements Object 

Index 
Sub-Index 

Slave 
Address 

SWD Index Request Type Length Data State Error Code 

0x3000 0x02 0x05 0x7F 0x00 0x78 (…) 0x02 0x00000000 

Table 18: Example SDO Read 
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9.2 Diagnosis/Status Response 
Diagnostic messages of the SWD slaves and the state of the gateway are 
reported via Error Entry Object 0x1003 or status response telegram. The 
number of the current diagnoses can be read from the object 0x1003/0. 
The individual diagnoses are presented in detail from 0x1003/1 onwards. 

Structure Error Entry 

Structure Error Entry 
Entry Type 
(2 bytes/UNSIGNED16) 

0x7000 

Error Code: 
(2 bytes/UNSIGNED16) 

00xx = Error reset  
(no errors) 

FFxx = specific to the device 

Time Stamp of Event 
(8 bytes/UNSIGNED64) 

Additional information: 
(8 bytes/UNSIGNED64) 
Byte 0: SWD diagnostic code 

Byte 1 – 4: Error flags 

Unused bytes have value 0 

Table 19: Structure of Error Entry 

If Error Code 0xFF01 to 0xFF63 is displayed, byte 0 of the Additional 
Information field features a diagnostic code. 

The ID of the slave reporting the error is located in the LSB (least 
significant byte) of the error code. The subsequent table lists some 
examples of extended diagnostic messages.  

Diagnostic code Meaning Used by 
0x00 No diagnostic message 

active 
All devices that support the 
extended diagnosis 

0x10 Contact in middle 
position  

RMQ 

0x11 Contact short-circuit RMQ

0x13 Output overload I/O module 

Table 20: Diagnostic Messages 

More detailed information on this can be found in the manual SmartWire-
DT Units, 05/11 MN05006001Z-EN by Eaton. 

If Error Code 0xFF00 is displayed, a 32-bit variable with error flags is 
stored in the Additional Information field (byte 1 to 4). 

Byte 0 of the Additional Information is 0x00. 

Byte Bit dwBit Relevance Meaning 
0 16 Error SWD: Necessary SmartWire-DT 

slave is missing 
3 

1 17 Warning SWD: Optional SmartWire-DT slave 
is missing 

4 28 SWD: The use of compatible slaves is 
allowed 

4 
5 29

Info 
SWD: All slaves are registered as 
“optional” 

Table 21: Error Flags if Error Code = 0xFF00 



Updating Firmware 62/72 

SmartWire-DT Gateway | EU5C-SWD-POWERLINK  
DOC130802UM02EN | Revision 2 | English | 2013-12 | Released | Public  

10 Updating Firmware 
10.1 Overview 

The EU5C-SWD-POWERLINK Gateway is shipped with its most recent 
firmware already loaded. The version of the loaded firmware is stated on 
the device type label.   
The integrated web server of the gateway provides a function to update the 
firmware of the gateway by HTTP via its Ethernet interface. All you need is 
a PC with an ordinary web browser connected to the gateway via Ethernet. 
When you perform a firmware update, the old firmware file in the gateway 
will automatically be overwritten. The project configuration and the target 
configuration in the gateway remain untouched by the firmware update. 

10.2 IP Address of Gateway 
In order to connect to the WebServer, you need to know the IP address of 
the gateway. On shipment, the default IP address of the gateway is 
0.0.0.0. On commissioning, the gateway receives its IP address with the 
project configuration which you have created and downloaded to the 
gateway by using the SWD-Assist software. POWERLINK uses the 
IP address 192.168.100.x, appended by the individual Node ID (x) of the 
device. Thus, if you have defined Node ID 10 in the project configuration of 
the gateway, the gateway will have the IP address 192.168.100.10 after 
downloading the project configuration to the device. 

Using the Ethernet Device Configuration Tool 
Apart from POWERLINK, you can assign a temporary IP-address to the 
gateway by using the Eaton Ethernet Device Configuration Tool and 
the netIdent protocol. This temporary IP address is stored volatile in the 
gateway and is thus lost after power-off at the device. 
You can install this tool on your configuration PC by choosing the Install 
Planning and Configuration Tools option in the menu of the start screen 
of the product DVD, and then selecting the Ethernet Device 
Scanner/Configuration Tool option in the opening SmartWire-DT 
Installation Wizard (as an alternative, you can also double-click the 
EnDevConfigTool.msi file in the Software\EnDeviceCfg folder). 
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For information about how to use this tool, please refer to the operating 
instruction manual Ethernet Device Configuration, which is stored on the 
product DVD in the Documentation\english\1.Software\Ethernet 
Device Setup Utility directory. 

Note: Before you can use the Ethernet Device Configuration Tool to 
assign a temporary IP address, you first have to perform a special reset 
operation on the gateway, in order to deactivate the POWERLINK 
connection. For this special reset, you must briefly disconnect the gateway 
from the voltage supply and keep the configuration button pushed in for 
two to three seconds while reconnecting the voltage supply. The BS and 
BE LEDs will automatically turn off after successful reset (for the positions 
of the configuration button and the LEDs on the gateway, see section 
Device Picture on page 27). 

After having set the temporary IP address and having updated the 
firmware in the gateway via web browser and WebServer, you must 
perform an ordinary reset of the gateway.  
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10.3 Prerequisites 
 The gateway is connected to a power supply.

 The gateway is connected to an IP network via its Ethernet interface.

 PC with web browser connected to the IP network.

 The IP address of the gateway is compatible to the Ethernet subnet of
the PC.

 You know the IP address of the gateway.

Note: The current version of the firmware does not provide options to 
customize the user authentication of the web server by creating own 
groups, users or passwords.  

10.4 Step-by-Step Instructions for Updating Firmware  
1. Open web page for firmware update.

 Start the web browser on your configuration PC.

 In the address bar of your browser, enter the URL of the gateway:
http://<IP address>

 The home page of the WebServer opens.

 In the navigation header of the web page, click Firmware Update.

Note: You can also open the firmware update page by entering the 
IP address http://<IP address>/fwupdate in the address bar of 
your browser. 

 The following web page opens:

Figure 27: Firmware Update via HTTP (as depicted in Internet Explorer) 
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The Firmware Identification section displays the following parameters of 
the firmware currently loaded in the gateway: 

 Channel: Location (port) of firmware

 Name: Name of loaded firmware

 Version: Version of loaded firmware

 Date: Date of creation of loaded firmware

The Firmware Update section features the following control elements:

Control element Function 
Browse… Opens the file selection dialog 

Transfer Uploads selected firmware file to the device 

Cancel Cancels firmware update 

Table 22: Controls in Firmware Update Page 

2. Select new firmware file.

 Click Browse… button, to open a dialog window for selecting the
firmware file.

 Navigate to the directory in which the firmware file is stored, select the
file, and then click Open.

Note: The name of the firmware file for the gateway is E030K0U0.nxf. 

 Path and name of the selected file are displayed in the field next to the
Browse… button.

3. Download firmware file to gateway.

 
Hazard of device damage by power failure during file transfer! 
Do not interrupt the power supply during transfer of the firmware file. 
A power failure while switching from the old to the already stored new 
firmware can cause severe malfunction of the device. 

 Click Transfer button to download the new firmware file to the gateway.

 After you have started the upload by clicking the Transfer button, the
validity of the firmware file is being checked by the system. If the file
fails the validity check, the file will not be stored in the gateway and an
error message will be displayed. If the file passes, the old firmware file
in the gateway is overwritten by the new firmware. Afterwards, the
WebServer requests a reset, in order to start the new firmware.
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10.5 Resetting Gateway 
After firmware download, you must reset the gateway in order to start the 
new firmware. If you have assigned a temporary IP address to the gateway 
with the Ethernet Device Configuration Tool, please note that the gateway 
loses this address after reset. The gateway then can be reached again 
under the IP address defined in the project configuration. If no project 
configuration is present in the device, the gateway falls back to its default 
IP address 0.0.0.0. 

To reset the device, proceed as follows: 

1. Open web page for reset.

 In the navigation header of the web page, click Reset.

Note: You can also open the reset page by entering the IP address 
http://<IP address>/reset in the address bar of your browser. 

 The following web page opens:

Figure 28: Reset via HTTP (as depicted in Internet Explorer) 

Important! 

Please note the following consequences of a reset: 

 The firmware is being restarted and connections will be interrupted or
timed out.

 I/O bus communication is being stopped.

 A temporary IP address assigned by the Ethernet Device Configuration
Tool will be lost.

2. Perform reset.

 Activate the checkbox in front of Please confirm… to acknowledge that
you want to reset the device.

Note: You can use the Cancel button to uncheck the checkbox in front of 
Please confirm... 

 Click Submit button to start the reset.

 The device is reset.
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11 Technical Data 
11.1 Technical Data EU5C-SWD-POWERLINK Gateway 

Category Parameter Value 
Part number 9233.920 

Dimensions  
(W x H x D) 

35 x 90 x 127 mm 

Weight 160 g

Mounting Top hat rail 35 mm (IEC/EN 60715) 

Mounting position Vertical 

Standards IEC/EN 61131-2

Communication controller netX 50 processor 

Configuration and diagnostic 
interface 

Mini-USB 

General 

Integrated memory 8 MB SDRAM 
4 MB serial Flash EPROM 

Protection type  
(IEC/EN 60529, EN50178, VBG 4) 

IP20 

Vibrations  
(IEC/EN 61131-2:2008) 

Constant amplitude 3.5 mm: 5 – 9 Hz 
Constant acceleration 1 g: 9 – 150 Hz 

Mechanical shock resistance  
(IEC/EN 60068-2-27) 

Semi-sinusoidal 15 g/11 ms: 9 Shocks 

Drop to  
(IEC/EN 60068-2-31) 

Drop height: 50 mm 

Ambient mechanical 
conditions 

Free fall, packaged  
(IEC/EN 60068-2-32) 

Drop height: 1 m 

Operating ambient temperature  
(IEC 60068-2) 

-25…+55 °C

Condensation Prevent by suitable measures 

Storage -40…+70 °C

Ambient climatic 
conditions 

Relative humidity, non-condensing 
(IEC/EN 60068-2-30) 

5…95 % 

Pollution degree 2 

Electrostatic discharge  
(IEC/EN 61131-2:2008) 

Air discharge (Level 3): 8 kV 
Contact discharge (Level 2): 4 kV 

Electromagnetic fields  
(IEC/EN 61131-2:2008) 

80 – 1000 MHz: 10 V/m 
1.4 – 2 GHz: 3 V/m 
2 – 2.7 GHz: 1 V/m 

Radio interference suppression 
(SmartWire-DT) 

EN 55011 Class A 

Burst  
(IEC/EN 61131-2:2008, Level 3) 

Supply cables: 2 kV 
POWERLINK bus cable: 1 kV 
SmartWire-DT cables: 1 kV 

Surge  
(IEC/EN 61131-2:2008, Level 1) 

Supply cables: 0.5 kV 
POWERLINK bus cable: 1 kV 

Electromagnetic 
compatibility (EMC) 

Radiated RFI 
(IEC/EN 61131-2:2008, Level 3) 

0.15 – 80 MHz, 10 V, 80% AM / 1 KHz 
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Category Parameter Value 
Rated operational voltage 24 V DC 

-15 % +20 %

Input voltage residual ripple ≤ 5 % 

Protection against polarity reversal Yes 

max. current Imax 3 A 
Note: If contactors with a total power consumption 
> 3 A are connected, a power feeder module
EU5C-SWD-PF1/2 has to be used.

Short-circuit strength No, external fuse FAZ Z3 

Heat dissipation Typ. 1 W 

Potential isolation No 

Supply voltage UAUX 

Rated operating voltage of 24-V-DC 
slaves 

Typical UAUX -0,2 V 

Supply voltage 24 V DC 
-15 % +20 %

Input voltage residual ripple ≤ 5 % 

Protection against polarity reversal Yes 

Rated operational current I 111 mA (with two participants) 

Heat dissipation at 24 V DC 2.66 W (with two participants) 

Potential isolation between UPOW 
and 15-V-SmartWire-DT supply 
voltage 

No 

Bridging voltage dips 10 ms 

Repeat rate 1 s 

Supply voltage UPOW 

Status display POW LED 

Rated operational voltage Ue 15 V ± 3 % 

max. current Imax 0.7 A 
Note: If contactors with a total power consumption 
> 0.7 A are connected, a power feeder module
EU5C-SWD-PF2 has to be used.

SmartWire-DT supply 
voltage 

Short-circuit strength Yes 

Connection type Push-in terminals 

solid 0.2 – 1.5 mm2 (AWG 24 – 16) 

Connection supply 
voltages 

Flexible with ferrule 0.25 – 1.5 mm2 

Participant type SmartWire-DT master 

SmartWire-DT Master ASIC SWD-80P-RS485 

Number of SmartWire-DT slaves 99 

Baud rate 125 / 250 kBd 

SmartWire-DT network 

Address setting Automatic 
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Category Parameter Value 
Status display SmartWire-DT master: SWD LED, duo color 

red/green 
Configuration: Config LED, duo color red/green 

Connections Plug, 8-pole

Plug connectors Blade terminal SWD4-8MF2 

Function of gateway POWERLINK Controlled Node (Slave) 

Baud rate 100 MBit/s 

Interface type 100 BASE-TX 

Half duplex/full duplex Supported  

Auto-Negotiation Supported

Auto-Crossover Supported

Address setting  By project configuration 

Status display POWERLINK Controlled Node: APL, BS, BE 
LEDs, duo color red/green 

Connector socket 2 x RJ45 

Connector plug RJ45 

Ethernet POWERLINK 
network 

Potential isolation Yes  

Table 23: Technical Data EU5C-SWD-POWERLINK Gateway 

11.2 Technical Data POWERLINK Controlled Node 
Parameter Description 
Maximum number of cyclic input data 1490 bytes 

Maximum number of cyclic output data 1490 bytes 

Acyclic data transfer SDO Upload/Download 

Functions SDO over ASND and UDP 

Baud rate  100 MBit/s, half-duplex  

Data transport layer Ethernet II, IEEE 802.3 

Ethernet POWERLINK version V 2 

Limitation No slave to slave communication 

Reference to firmware/stack version V2.1.x.x 

Table 24: Technical Data POWERLINK Controlled Node (Slave) Protocol 
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